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what’s inside

The Energy Research and Development Division
(ERDD) offers this style guide instructions in union
with the ERDD template for technical reports.

All questions and comments are encouraged
and welcomed.

Please contact our division at (916) 327-1551
or send an email to ERDD@energy.ca.gov.

Thank you.
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-set-up tips:

To ensure a successfully formatted report, first review the following set-up tips:

First, select ‘Show/Hide [’ icon to show para-
graph marks and other hidden formatting
symbols located on the ‘Home’ tab. This will
prevent deleting Section Breaks that change
the layout or formatting of a page or pages in
the report.

Page Layout References Mailings Review View Acrobat

pe - |11

Font F] Paragrapgh F]

Section Breaks are used to change the layout
or formatting of a page or pages in your docu-
ment. For example, you can use sections to
rotate a page to landscape or portrait orienta-
tion.

Save Photos in their original or raw digital
format (if available) as well as in JPEG or PNG.
Do not use TIF or GIF files unless no other option
is available. Graphics and photographs should
be saved at a higher resolution, at least 300 dots
per inch (dpi). Do not use low-resolution (72 or
96 dpi) graphics found on websites, as they do
not reproduce well in printed documents.

Make sure Bracketed Text are filled in with the
correct information, i.e. [fill-in text], then remove
brackets.

\

L

i

ftnote'

Use the Active Voice whenever possible:
ACTIVE VOICE: The petroleum industry builds
new storage facilities.

PASSIVE VOICE: New storage facilities are
built by the petroleum industry.

While working on the report, if a section or
paragraph is cut & pasted into the document,
the Paste Option icon will appear.

&
' EKeep Source Formatting
O Match Destination Formatiing
C  Keep Text Only
Set Default Paste...

RIGHT click and select ‘Keep Text Only’.
This will revert any formatted text to the format
pre-selected for ERDD final/technical reports.

Use Footnotes (not endnotes) in reports. Place
footnotes at the bottom of the page on which
they appear, after periods or commas.

Insert footnotes using Word footnote feature:
Insert > Reference > Footnote.

Do not use footnotes in report or chapter titles,
and do not footnote headings or subheadings.




Each text within the live document is assigned a “style”
or a set of formatting characteristics, such as font name,
size, color, paragraph alignment and spacing. When
styles are used to format documents, it can quickly and
easily apply a set of formatting choices consistently
throughout the document, saving time and making
documents look good.

To change text to match the appropriate style, select
text, then select Name of Style in the ‘Styles’ window.

styles window-

(7}
- A4 Find -
AsBBCeD! A:EbceDdEn AgBbC 4a85CcDd aaBbCeDdE . Replace
- ae
Bock Title TCaption  TChapter Ti..  Emphasis Figure Title  _ g;“gf l§ Select -
Styles I Editing

To view the styles window, click here on the ‘Home’ tab.
This ‘Styles’ window will appear.

Here are the common List of Styles used thoughout the report:

Name of Style

Captions

Credit + Source

Figure Title

Header 2

Header 3
Header 4

Heading 1, Chapter Titles

Normal

Reference — Bibliography

Table Title

Style Application Typeface Sample
Photo caption below image. Arial, 10pt, Align Text Left Sample
Photo credit source below photo | A1) g0t Align Text Left Sample
caption.
Descriptive title of the photo.
Photo titles are labeled Arial, 10pt, Center, Bold Sample
sequentially.
The first sub-heading in a Chapter . .
Subheadings may be written in Sglzl’ 14pt, Align Text Left, 11 (TAB)SampIe

scientific numbering format.

The sub-subheading in a Chapter.

Arial, 12pt, Align Text Left

1.1.1¢28) Sample

The sub-sub-subheading in a
Chapter.

Arial, 11pt, Align Text Left,
Italicized

1.1.1.1a8)Sample

ch . . Arial, 18pt, Align Text Left, CHAPTER 1:
apter titles, Appendix titles. Bold .
Sample Title
Palatino Linotype, 11pt, Align
Body of Text. Text Left P ’ ’ Sample
Palatino Linotype, 11pt, Align
Text of references. Text Left with 0.5” Hanging Sample
Indent
Title of the table. Avial, 10pt, Center, Bold Sample 1:

D)

v X

Clear Al

({Latin) Arial

(Latin) Arial, 14 pt, Bold, All caps
{Latin) Arial, Bold

(Latin) Arial, Bold, Centered
{Latin) Arial, Centered
(Latin) Arial, Right

After: Opt

Background 1

Balloon Text

Bold

Bold, After; 0pt

Caption

Captions

Captions + Left: 0.757, After; 0pt
Centered

Comment Reference

Comment Subject

Comment Text

Credits + Sources

Credits + Sources + Left: 0,317
Credits + Sources + Left: 0.75"
Default

Bulleted, Symbal {symbal}, Left: 0.25%, Hanging: 0.:

[ shaw Preview
[ bisable Lirked Styles

options. ..
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-outline of report

This is the outline of the technical report template. Each section is detailed throughout the template.

cover
prepared by
acknowledgements
preface
abstract
table of contents *
list of figures/tables *
executive summary
blank page *
body of report
glossary
references
appendices

*Information on formatting these sections is located in the Finalize Report Format section, pages 18-21.




cover

Energy-Research-and-Development-Divisionf]
Choose ‘interim’ OR ‘final’ report. INTERIM/FINAL-PROJECT-REPORTY]

Insert title of report in all caps,
subtitle if needed.

T
T
T
Preparedfor.— California Energy- Commissiont]
Insert contractor company, Preparedby:—+ [Company]] 1
then remove brackets.
MONTH-YEARY
|nsert JPEG here_ InsertLogo-Heref CEC-500-¥YYY-XXXT

Energy Commission
will provide information.
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Fill in the top portion of this page.

Energy Commission Contract
Manager will provide the bottom
portion information.

Disclaimer is mandatory.

PREPARED-EY:

1

Frimary-Author{s)q

— Firstiame-LastMameT

— SecondAuthory]

— Third-Author]

=1

Company]

123-Addresst]

City, ST123459

P o ne R R R H R K | e X - -
hitp:dawww company com-(optional 1]
a

R | E—

ContractNumber:=XXX-XX-XXXT
1

1

Preparedfor:|

1
California-Energy-Commissiony

1

R R ]
ConfractManagery
1

R ]

OfficeManager]]
EnergyX0000000¢ Research Office
1

LaurietenHopey
Deputy-Director]]
ENERGYRESEARCHAND-DEVELOPMENT-DIVISIONT|

1
RobertF.-Cgleshyy]
Executive-Directory

1

s JCEHON Break (Mext Page)..

DISCLAIMERTY
1

sccuracy-oradequacy-oftheinformationin thisreport

This- mport was-prepared-as-the result of work sponsored by the- Calforna-Enargy- Commission.- it
doss notnecessanly: moresent-the views of the Enargy Commission, izempiyees orthe Siste of
Calfomia. The- Energy- Commission, the State- of Cslfoma, itz employess, contractors: and:
subcontmeotors: make- no- warranty, express or implisd, and- assume no- egal Iability- for the
nformaton in- this report;: nor does any- party- mpe==nt-that the- uses- of this information- will- not:
nfringe- upon- privately- owned- rights.- This- mport- has-not- besn- approved- or- disapproved- by- the:
Califomia- Enargy Commission: nor- hes- the: Calfoma: Enegy Commisson- passed- upon- the
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ACKNOWLEDGEMENTSY
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acknowledgements

This page comes after the credits page,
is the first text page of the document,
and precedes the Preface, Abstract, and
Table of Contents.

The Acknowledgements page expresses
appreciation to those who participated in
generating the report. It may be a para-
graph or a bulleted list of names and, if
appropriate, their affiliations. If there is

a long list of participants who are to be
acknowledged, put the names and
affiliations in two or three columns
(reducing font size so that the names fit
on one page).

Acknowledgements are optional.

Write in third person, i.e., “The author
would like to thank...”

Page numbering begins on this page
with lowercase Roman numeral (i).
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Default ERDD language

is mandatory.

Fill in the bracketed portion
of this page, then remove
the brackets.

PREFACEY

The{alifornia Ensrgv-Commission-EnsrgvResearch-and DevelopmentDivisionsupports-

publicinterestenergvresearchand-developmentthatwill helpimprove the qualitvoflifein-
Californiaby bringing envirormentallvsafe, affordable andreliable energyservicesand-
productstothemarketplace

The-Ensrgy Researchoand Development Division-conductspublicinterestreszarch, -
development, and-demonstration{RD&D ) projectstobenefit-California. {

TheEnergy Research-and Development Division strivestoconduct the most promisingpublic-
intsrestensrgyv research by partmering withRD&Dentities, indudingindividuals, businsssss, -
utilities, and publicor private researchinstitutions. T

Energy Researchand Development Division funding effortsare focused-onthe following:
ED&Dprogram-arsas:|

*— BuildingsEnd-Use Energv Efficdency|

*— EnergvInnovationsSmall GrantsT

*— Energv-Related Environmental Research T

*— EnergvSvstemsntegrabiony

*— EnvironmentallvPreferred-Advanced Generation|

*— Industrial/Agricultural Water End-Uss Ensrgv-Efficdency |
*— Renswable Energv TechnologiesT

*— Transportation|

1

[Reportfiflean-tfalics]-isthe {final orinterim — select-one] reportfor-the [project name] project-
[contractrumber 2000000 work authorization mumber{insert 2 lor grantnumber {insert-
F1conducted by {researchentity]. Theinformation from thisproject contributesto Energy
Reszarch-and DevelopmentDivision's{insert RD&D program area frombulletedlistabove]
Program. |

.|

Formaoreinformationaboutthe Energy Researchand Development Division, please visitthe-
EnergyCommission’swwebsite-atawwiw energy.ca.gov/research/-orcontact the Energyv-
Commissionat916-327-15351.90

il

Page Break




ABSTRACTY

Typehera |

evwords:-Tvpskevwordshers] —

[ R = I N e e - e -l I s e s s e e e e s e e = s == I == |

Pleaseuse thefollowing dtationfor thisrepart:| |

Lastname, Firstname;-Second-author; Third-author { Company Name L. Y YYY . -TitleofReport.:

California Energy-Commission. Publicationnumber CEC-300- Y Y- 2)00CT

Page Break,

i

abstract

All Energy Commission reports are required

to have a short abstract:

» The abstract is less than 300 words with
no acronyms.
The abstract is written at a basic technical
level with any technical terms defined.
The abstract is readable to the legislators,
policy makers, stakeholders, researchers,
academia, investors, and the general public.
The abstract includes:
* Major Results and Benefits to
California Ratepayers
* Purpose and Methodology
* Problem Statement, Conclusions,
and Recommendations

Keywords: The abstract page must contain
five or more keywords that will help search
engines and other databases find the report
subject matter. Do not repeat words. No
period at end of list of keywords

 This report should not refer to other reports
unless it is essential to clarify the document
purpose. If the report is a supporting docu-
ment to another report, that information
should be noted. Do not, however, include
citations within the abstract.

Year published.

Energy Commission will provide this
information.

« If applicable, please make the following
Statement after the last paragraph of
abstract:

“Photos without citation are sources by author.”
| 9
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The Table of Contents (TOC), List of
Figures (LOF) and List of Tables (LOT)
sections are automatically generated
through heading links after report is
completed.

See , pages 18-20.

TABLE-OF-CONTENTS-

Acknowledgements... i ——————— e s i1l
PREFACE...mmmmmmsssssssssn L i1
ABSTRACT ..o s iii T
TABLE-OF-CONTENTS s i —————— ivT
LIST-OFFIGURES .o S ——————— ivT
LIST-OF TABLES.....cissssssssssssssnsssans e s b vy
EXECUTIVE-SUMMARY s L s 17
Introduction-Headmg -2} .o TRt ettt 11
Background-(Heading-3). ..o Rt 11
CHAPTER 1:-Title-of - Chapter....ccocnnnn s 31
L1 Heading oo ettt 31
111 & Heading oo B e 31
1.2 o Heading oo ettt 31
CHAPTER-2:-Note That-There-Is-No-Blank-Page-BetweenChapters......cvcennne. B 49
21 = Heading o ettt 41
2101 = Heading .o R ettt 41
22 9 Heading oo =
GLOSSARY s
REFERENCES...cinmmmmnmssssss s

Figure-1:-Descriptive-Photo-Title-

Figure-2:-Average Rack Pricesfor-"CARBOB" -Gasoline ... T £
1
LIST-OF-TABLESY
Table-1:Tifleof Table Goes-Here -+ 41
Table-2-Tifls-of- Table-Goes-Hers -+ 51
T Section Break (Mext Page)
iv




EXECUTIVE-SUMMARYY

« Introductiony
Tvpehere
= ProjectPurposef
Tvpehere |
= Project-Results|
Typehers.q
= Project-Benefitsy
Typehere g
1 Section Break (Mext Page)

executive summary

The Executive Summary is a final
report in miniature, and should include
the following:

» A brief overview of the report no longer
than ten pages.

* General terms, for a non-technical
audience with any technical terms
explained to the reader.

» Readability to the legislators, policy
makers, stakeholders, researchers,
academia, investors, and the general
public.

Includes:

INTRODUCTION
Problem Statement and Background
Information

PROJECT PURPOSE
Goals and Objectives, and Involvement
from Stakeholders

PROJECT RESULTS
Methodology, Analysis of Results, Conclu-
sions, and Recommendations

PROJECT BENEFITS
Current, Future, or Potential Benefits to
California Ratepayers

1T

The Executive Summary always
begins on page 1.

| 11
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blank page

A blank page is inserted to ensure Chapter 1
starts on an odd number page.

See Finalizing Report Format, page 21.

Ablank pagedisinsertedtoinsure Chapter-l startsonanoddnumberpage. Blank pagesarenot-
labeled. Section Break (Mext Page)

Blank pages are not page numbered.




[

‘CHAPTERA{+)

Title-of-Chaptery
. 1.1+ Headingf

Subhe=adingsmayvbeswritteninsdentificnumberng format. T
= 1.1.1+Headingq

AllEnergy Commissionreportsare printed-doublesided. T
« 11,1 fHeadingy]

Define tachnical terms, avoidjargon, and-discussresultsrather thanlistingthem T
. 1.2+ HeadingT

Thisizan=xamplsofa-sdentificsubheading breaky. T

Figure1:-Descriptive-Photo-Title-Here]

Photo-captionhere{optional)Arial 10-point.g]
Pheito-Credit: Photo-source here.-Aria 8-point 1

1
Aboveisanexample-ofhowtoindudsaphoto-and theassodatad-cradits. T

1

Pade Ereak.

;’}-Ex ampleofafootnots. T

3

body of report

Chapters should be numbered
(CHAPTER 1:, CHAPTER 2;, etc. in
upper case) followed by a colon, a
shift-return (soft return), and then the
chapter title in title case.

Shift Return is used to ensure corrected
format in TOC.

Use scientific or technical section num-
bering for subheadings within chapters.
(1.1,1.1.1, etc.)

Heading format is described in the
List of Styles table, page 3.

Insert a Page Break to insure each
chapter will begin on an entirely
separate page.

Chapter 1 always begins on the right-
hand side.

| 13
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Here is another example of a Chapter
Page. Please note the formatting for
chapter titles, headings, tables, and
pictures are consistent throughout the
entire document.

There is not a blank page between
chapters.

CHAPTERZ2:~
Title-of-Chaptery

Thisizoptonal introductorytextbeforeHeadings. T

.21~ Heading-27
=2.1.1+Heading-31

Belowrisansxampleofhowtoindudeatable T

Table1: Title-of Table]

_ Headings A Heading« ' =
Heading-o In-Boldo Heading-In-Boldo In-Bolda Headingo
[nfom Datas Datas Data= Mumbered-|=

Datas
Right-align’]
q

Sounce- TahiE SoCehers Fnals PO, )

il

.2.2+ Heading-27
Chartsars-also-considerad Figures, and should be numberad sequentiallv.-]
Figure-2:-Average -Rack-Prices-for-*CARBOB"-Gasoliney

250
240
220

210
20

Contn Gallan
&
oo

(As of 1/4/110)

CARBOB (For Ethanol Blending)
Average Rack Prices

— e ]

£ Catamis




GLOSSARYY
Thisizan=xample-ofBody{Normal) Text. ItisPalatino Linotvps, 11 point, and-alignedleft.-]

Aglossarvisrequired.

All ERDD reports are required to have

Belowisanexampleoftermsand-definitionsin-atable format | a g/ossary.
11 - " . "
T S ~ Please provide a Glossary with defini-

_ tions for each acronym or term. Use
EFICx Electric Program Investmant-Chargex I

Microsoft Word table feature to create a
Smart{Crids Smart{Gridisthe thoughtful integrationofintelligenttechnologiesand-  |= two-column format with the acronym or
innovative servicesthat produce-amore 2ffidant, sustainable, economic, -

and sacure 2lectrical supplvforCaliforniacommumnities = abbreviation in the left column and the

T T B definition in the right column.

T Glossary Table example.

........................ Page Break

| 15
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references

The References section at the end of
the report must list all documents cited
in the body of the report. List references
in a standard alphabetical format.
Check that all of the references
contained in the body of the report are
accurate and that the full citation for
each reference is listed in the
References section.

List any documents referred to in the
appendices in a reference section in
that appendix; that is, each appendix
carries its own Reference section.

REFERENCEST

LastName, FirstName. Text-and/orinformation yousvishto refer thoughout vourreport -
PublicationCompany. YYYY. ]

T Section Break (Mext Page)




-APPENDIX-A:+
Title-of-Appendixy

Smallerappendicesare-attached o the mainreport Longerappendicesmay be publishad-
separately underdifferent publicationnumbers.

1
1

Section Break {Mext Page)

e
=9

appendices

An appendix is supplementary material
that is produced by the report author.

Designate appendices by capital letters
(Appendix A, Appendix B, Appendix C,
etc.), not numbers.

Insert a Section Break at the end of
each appendix to insure each appendix
starts with a new page number.

See below.

Page numbers are labeled by capital
letter designated by each appendix.

| 17



TABLE OF CONTENTS

Now that the content of the report is
complete, the Table of Contents will
need to be updated:

RIGHT click in the body of the table.
Select UPDATE FIELD

Palatino Lino - |11 - | A" & A~
B 7 =& . A . iE iE = .
At ;
fa
=3
[ | Paste
2 Update Field
Edit Field...
Toggle Field Codes
A | Font..
=T | Paragraph...
= Bullets »
éE Mumbering | ]

Select UPDATE ENTIRE TABLE

IpdatenliablSoiaContents dﬂ‘

Word is updating the table of contents, Select one of the
following options:

) Updat

bers anly

Click OK.

TABLE OF CONTENTS

Acknowledgements i
PREFACE ii
ABSTRACT iii
TABLE OF CONTENTS iv
LIST OF FIGURES iv
LIST OF TABLES iv
EXECUTIVE SUMMARY 1
Introduction (Heading 2) ........ccoeueiririiiiiiiiie s 1
Background (Heading 3) ... esaans 1
CHAPTER 1: Title of Chapter 3
11 HEAMING vttt 3
1.1.1 HEAAING ...voee 3

1.2 HeEAdING ..o 3
CHAPTER 2: Note That There Is No Blank Page Between Chapters 4
2.1 HEAAING ..o 4
2.1.1 Heading ..o 4

2.2 Heading ..o 4
GLOSSARY 6
REFERENCES 7
APPENDIX A: Title of Appendix A-1

LIST OF FIGURES

Figure 1: Descriptive Photo Title HeTe........ccccouiiiiiiiiiiiicicccc s

Figure 2: Average Rack Prices for “CARBOB” Gasoline

LIST OF TABLES

Table 1: Title of Table Goes Here
Table 2: Title of Table Goes Here




TABLE OF CONTENTS

Acknowledgements i
PREFACE ii
ABSTRACT iii
TABLE OF CONTENTS iv
LIST OF FIGURES iv
LIST OF TABLES iv
EXECUTIVE SUMMARY 1
Introduction (Heading 2) ........ccocuciriiiniinieieicicicct st 1
Background (Heading 3) ........ccouiuiiiiiiiiiiiiiicc s 1
CHAPTER 1: Title of Chapter 3
L1 HEAING cooeevieciiciic ettt s 3
1.1.1 HEAAING ... 3

1.2 HeEAdING oot 3
CHAPTER 2: Note That There Is No Blank Page Between Chapters 4
2.1 HEAAING ..o 4
2.1.1 HeEAdING ..o 4

2.2 HEAAING oo 4
GLOSSARY 6
REFERENCES 7
APPENDIX A: Title of Appendix A-1

LIST OF FIGURES

Figure 1: Descriptive Photo Title Here
Figure 2: Average Rack Prices for “CARBOB” Gasoline

LIST OF TABLES

Table 1: Title of Table Goes Here
Table 2: Title of Table Goes Here

LIST OF FIGURES/LIST OF TABLES

To update:

RIGHT click in the body of the list.
Select EDIT FIELD...

=3

& | Paste

=t Update Field
Edit Field...

Toggle Field Codes

A | Font..
= Paragraph...
= Bullets »

T

MNMurmbering o

Select TABLE OF CONTENTS...

Fiald

am|

Please choose a field

Field properties

Categories;

(A [v]

Eield names:
Section

SectionPages -]
Seq

Set

Skiplf

StyleRef

Subject

Symbol

Ta

dugnced fisld options

e
Template

Toc
UserAddress
Userlnitials
Userhame

S
I

Descriptian:
Create a kable of contents

Field Codes

[] Preserve Formatting during updates




To update , make sure FIGURE

is selected in the ‘Caption label’ drop-down box.

il O F e HEBR

[Tabie of Figures |

Prink Preyiew Web Preview

Figure 1: Text ...... Q Figure 1: Text Q
Figure 2: Text .. B Figure 2: Text.... E_lj
Figure 3: Text .. Figure 3: Text....

Figure 4: Text . Figure 4 Text....

Figure 5: Text ...... Figure 5: Text

[<]
<]

Show page numbers
Right align page numbers

Tab leader: ... D

[[] Use hyperlinks instead of page numbers

General

Fufmats: From template

gption label: | Figure

e |abel and number

To update , make sure TABLE is
selected in the ‘Caption label’ drop-down box.

Table of Figures asl
Table of Figures

Prink Prewview Wweb Preview
Table 1: Text.... B | [Table 1: Text... [~]
Table 2: Text EJ Table 2: Text... 3 EI]
Table 3: Text.... Table 3: Text... 5
Table 4: Text.... Table 4: Text... 7
Table 5: Text.... Table 5: Text... .10

v ]

show page numbers
Right align page numbers

Tab leader: ... D

[ Use hyperlinks instead of page numbers

General

Fopfnats: From template D
Cagtion label: | [N

Inetude label and number

Click OK.

TABLE OF CONTENTS

Acknowledgements i
PREFACE ii
ABSTRACT iii
TABLE OF CONTENTS iv
LIST OF FIGURES iv
LIST OF TABLES iv
EXECUTIVE SUMMARY 1
Introduction (Heading 2) ........ccoeueiririiiiiiiiie s 1
Background (Heading 3) ... esaans 1
CHAPTER 1: Title of Chapter 3
11 HEAMING vttt 3
T HEAGING wovoovveeoveeer s sssses s s ssssess s sssses s 3

1.2 HeEAdING ..o 3
CHAPTER 2: Note That There Is No Blank Page Between Chapters 4
2.1 HEAAING ..o 4
2.1.1 Heading ..o 4

2.2 Heading ... 4
GLOSSARY 6
REFERENCES 7
APPENDIX A: Title of Appendix A-1

LIST OF FIGURES
Figure 1: Descriptive Photo Title HeTe........ccccouiiiiiiiiiiiicicccc s 3
Figure 2: Average Rack Prices for “CARBOB” Gasoline...........ccccoovvininininininininiiniicncescnenenns 4
LIST OF TABLES

Table 1: Title of Table Goes Here 4
Table 2: Title of Table Goes Here 5




Ablankpageisinsertedtoinsure Chapter-l startson-an-odd-numberpage. Blank pagesarenot-
labeled. Section Break (Mext Page)

BLANK PAGE

A blank page is inserted to ensure
Chapter 1 starts on an odd number
page.

After completing the report text, update
the TOC, LOF, and LOT. If Chapter 1
begins on an odd page, the final/technical
report is complete.

If Chapter 1 begins on an even page,
delete this blank page. Then update TOC,
LOF, and LOT again.

Congratulations!

The final/technical report is complete.

Blank pages are not page numbered.

| 21
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